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Einfuhrung

Tanner EDA ist ein Schaltkreisentwurfssystem fur digitale, analoge und Mixed-Signal-Schaltkreise. Es
beinhaltet mehrere Softwarewerkzeuge fur das Zeichnen von Stromlaufplanen, die Logik- und Timing-
Simulation, den Layout-Entwurf und die Layout-Verifikation. Einen Uberblick bietet die folgende kurze
Beschreibung.

S-Edit (Schematic Editor — Grafische Eingabeoberflache zur Stromlaufplanerstellung):

S-Edit ist eine grafische Entwurfsoberflache fur die Eingabe von Stromlaufpldnen und fir deren Analy-
se. Hier kdnnen eigene Module entworfen oder vorgefertigte Module aus Bibliotheken wiederverwen-
det werden. Die mit dem Stromlaufplan erstellten Ausgabedaten kénnen zur Simulation
(T-Spice), zum Layoutentwurf (L-Edit) und zur Verifikation (LVS) verwendet werden.

T-Spice (Circuit Simulator — Schaltungssimulator):

T-Spice ist ein Schaltungssimulator fir den IC-Entwurf. Als Eingangsdaten verwendet T-Spice Textda-
teien. Diese beinhalten neben den Netzlistendaten auch Simulationsbefehle. Diese Dateien kénnen
mit einem Texteditor erzeugt werden, lassen sich aus S-Edit exportieren oder mit L-Edit aus einem
bestehenden Layout extrahieren.

W-Edit (Waveform Viewer — Betrachter fiir Signalverlaufe):

Mit W-Edit kdnnen die in T-Spice simulierten GréRRen visualisiert werden. Es sollte daher wahrend der
Simulation von T-Spice aufgerufen werden, um Simulationsergebnisse darzustellen.

L-Edit (Layout Editor — Grafische Eingabeoberflache zur Layouterstellung):

Fir die Schaltkreisproduktion notwendige Masken kénnen mit dem grafischen Entwurfswerkzeug L-
Edit erstellt werden. Die Masken werden in Layern verwaltet. Die Maskendaten werden als GDS II-
oder CIF-Dateien ausgegeben.

L-Edit/SPR (Standard Cell Place & Route — Platzierung und Verdrahtung von Standardzellen):
L-Edit/SPR wird innerhalb von L-Edit verwendet, um aus einer schaltungsspezifischen Netzliste, einer
Technologiedatei und einer Standardzellenbibliothek ein Standardzellen-Layout zu generieren. Die
schaltungsspezifische Netzliste wurde zuvor von S-Edit erzeugt. Sie enthalt eine Beschreibung des
Designs in Textform und die Verknipfungen mit den verwendeten Standardzellen.

L-Edit/DRC (Design Rule Check — Uberpriifung der Entwurfsregeln):

L-Edit/DRC ist ein Werkzeug, das die Einhaltung von technologischen Entwurfsregeln tberprift. Re-
gelverstoRRe kénnen direkt im Layout dargestellt oder in einer Textdatei ausgegeben werden.

L-Edit/Extract (Extraktion einer Netzliste aus dem Layout):

Durch Extraktion kann aus einem fertigen Layout eine beschreibende Netzliste erzeugt werden. Diese
Netzliste liegt im Berkeley-PSpice-Format vor, das von T-Spice und zum LVS-Netzlistenvergleich
(s. u.) verwendet werden kann.

LVS (Layout vs. Schematic — Vergleich von Layout und Stromlaufplan):

LVS gestattet den Vergleich von Netzlisten. Dadurch kann festgestellt werden, ob ein Layout einem
Stromlaufplan entspricht. Die Eingabe bilden zwei Spice-Netzlisten, die aus S-Edit und L-Edit (mittels
L-Edit/Extract) exportiert werden.



Ubungsablauf

In dieser Ubung soll der standardzellenbasierte Entwurf digitaler Schaltkreise mit dem Entwurfssystem
»1anner EDA Tools" trainiert werden. Die folgenden Schritte sind dafir notwendig:

I. Eingabe des Stromlaufplans der gewlinschten Schaltung in S-Edit.

[I.  Simulation der Schaltung im Schaltungssimulator T-Spice mit grafischer Ausgabe der Signalver-
ldufe in W-Edit.

Ill. Export von TPR-Netzliste (fir die Layouterstellung) und SPICE-Netzliste (fir LVS) aus S-Edit.
IV. Layoutentwurf

1. Verwendung des Layout-Werkzeugs L-Edit.

2. Auswahl der Technologiedatei, der TPR-Netzliste und der zu verwendenden Stan-
dardzellenbibliothek.

Bestimmung der Eigenschaften des Padframes.

Automatischer Layoutentwurf mit L-Edit/SPR.
V. Verifikation: Prifung auf Einhaltung der technologischen Regeln mit L-Edit/DRC, Generierung
einer Netzliste aus dem Layout mit L-Edit/Extract, Vergleich der aus dem Layout und aus dem
Stromlaufplan erzeugten Netzlisten mit LVS.

VI. Export der GDS Il-Daten fur die IC-Herstellung aus L-Edit.

U be rsic ht: Bauelemente- Standardzellen- Technologie-
Bibliothek Bibliothek Informationen
i i i
v v v
S-Edit TPR- L-Edit/SPR
Logik- Stromlaufplan- Netzliste Layout- — GDS Il-Daten
Entwurf Entwurf Entwurf
SPICE- SPICE- SPICE-
Netzliste Netzliste Netzliste
~ X
T-Spice / W-Edit \\‘ L-Edit/DRC/Extract/LVS
Schaltungs- Layout-
Simulation Verifikation
; .
Elektrische SPICE- Test-
Eigenschaften/ Analyse und Vektoren
Parameter der Output

Bauelemente

Nutzungshinweis zu Tanner Tools: D nEEErT
Die Oberflachen samtlicher Tanner-Werkzeuge ‘/ ” — o o
unterteilen sich in Menlileiste, Arbeitsflache

und mehrere Werkzeugleisten.

Es sollten keinesfalls Umlaute zur Benennung .
von Dateien, Bibliotheken, Modulen usw. ver-
wendet werden!

Name
Default display atrbutes ofthe nstance name of
this symbol




I. Eingabe des Stromlaufplans mit S-Edit

S-Edit unterscheidet zwei grundsatzliche Darstellungsarten:

e Stromlaufplan-Darstellung (Schematic Mode) zur Erzeugung eines Stromlaufplans.

e Symbol-Darstellung (Symbol Mode) zur Erstellung von Stromlaufplan-Symbolen.

Der Modus kann durch Klicken auf das jeweilige Symbol in der Menlleiste umgestellt werden.

Schritt 1: Erstellen eines einfachen Moduls Ag%

In diesem Schritt wird der nebenstehende Stromlaufplan
mit zwei Eingadngen, einem Ausgang, zwei Invertern, zwei
AND-Gattern und einem OR-Gatter erzeugt. B

1. Start des Programms S-Edit und Anlegen eines neuen Designs:

Start von S-Edit, Erstellen des Designs mit File > New > New Design. Benennen des
Designs als ,XOR". Es wird automatisch eine gleichnamige Bibliothek erstellt. Alle spater

selbst erstellten Module sollten in dieser Bibliothek angelegt werden.

Out

In das Feld ,Create in Folder wird der Pfad eingetragen, in dem das Design erstellt wer-

den soll (z. B. ,E:\Tanner\")". x]
Erstellen eines neuen Schematic-Views mit ™= [XoR S« |
Cell > New View. Die verschiedenen Felder cell: [ xor2 = cancel
sind wie in der nebenstehenden Abbildung ge- Vi [echematc =
Zelgt aUSZUfu”en. Interface narne: |ma\n LI
Hinweis: Die Namen des Designs und der Zel-
le sollten unterschiedlich sein. Visw name: [ man
[~ Disable name validation
2. Laden der Bauelementebibliothek:

Laden der Bibliothek mit )
File > Open > Add Library. 2

|E:'l,Tanner'l,Libraries'l,P.II'l,P.II.tanner j _I
Hinzufligen der Bibliothek
LAll.tanner aus dem Verzeichnis [ o | Cancel
.E:\Tanner\Libraries\All“. Dadurch
werden automatisch alle notwendigen Bibliotheken hinzugerth.

Libraries x|

Auswahl der Bibliothek ,LogicGates” aus der Navigationsleiste |[xor =]

3. Auswahl und Platzierung von Instanzen:

,Libraries”.

ands

3

4

Add.

| Remove

Auswahl des Gatters ,INV* und klicken auf ,Instance”. Es 6ff- |[fiter =l

net sich das Dialogfenster ,,Instance Cell“. Hier kann z.B. ein
neuer Namen eingeben werden.

Klicken auf die Position auf der Zeichenflache, an der das Gat-
ter erzeugt werden soll. Es werden zwei Inverter benétigt. Ein

Klick auf ,Done* schliel3t das Dialogfenster.

Wiederholung dieses Vorgangs fur die Gatter ,NAND2C* und

Cpen | -

Instance

=

,,NORZC“. Symbali  « | +| Mainof1

! Achtung: Das Verzeichnis ,E:\Tanner\* nicht zum dauerhaften Speichern von Daten verwenden! Es kdnnte durch einen
anderen Benutzer oder nach einem Neustart gel6scht werden!

2 Die Datei ,libraries.list* im Projektverzeichnis enthalt die Verweise auf alle geladenen Bibliotheken. Sollten Bibliotheken nicht
gefunden werden (,unresolved libraries®), sind die Pfade in dieser Datei zu andern.
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Anordnen der Gatter wie oben abgebildet. Die Elemente lassen sich dazu mit der rechten
oder linken Maustaste auswahlen und durch Festhalten der mittleren Maustaste ver-
schieben (auch mit Alt + linke Maustaste méglich)s.

4. Erstellen von Ports:

Erstellen von Eingangsports (iber das Symbol =| (Werkzeugleiste) und Klicken auf die
Position auf der Zeichenflache, an der das Symbol erzeugt werden soll. Es 6ffnet sich das
Dialogfenster ,In Port Settings®, in dem als Name ,A* eingetragen und der Vorgang mit
,OK"® bestatigt wird. Mit der Taste ,R* kann das Symbol danach rotiert werden.

In Pork Settings ﬂ

ET?é@@TE]DOEIE o =
e |

I™ Disable name validation

—Fant Size (pt) Auto-repeat
Is [ Enable auto-repeat futa-ncrement;
I¥ | Confirm text of each object 1 _:|
i~ Justification

Origntation  |\West 'I

NESFIErT

Wiederholen des Vorgangs fur den Eingangsport ,B*.

Erstellen des Ausgangsports ,Out‘ nach Anwahl des Symbols ©| und Klicken auf die Zei-
chenflache an der gewlnschten Position. Gegebenenfalls Beenden der Port-Eingabe
durch Klick auf % .

5. Verbinden der Gatter mit den Ein- und Ausgangsports:

Auswahl des Verdrahtungssymbols E in der Stromlaufplan-Werkzeugleiste.

Die Verdrahtung wird mit der linken Maustaste A D
gestartet und mit der rechten Maustaste been-
det.

Verdrahten der Schaltung wie abgebildet. Der
Verdrahtungsmodus wird mit einem Klick auf B
das Symbol k| oder tber die Taste ,ESC“ be-
endet.

Out

Alternativ kdnnen zwei grafisch unverbundene Teilnetze auch elektrisch verbunden wer-
den, indem sie die gleiche Bezeichnung (Net Label, Symbol: ¥7) zugewiesen bekommen.

Schritt 2: Erstellen eines Symbols fiir die eingegebene Schaltung

Jede Schaltung kann durch ein Symbol reprasentiert wer- x|
den, um die Sc__haltung in einer héheren Hierarchieebene besi: [vor = o
verwenden zu kdénnen. \—I
call: [ xor2 > cancel |
1. Erstellen eines neuen Symbol-Views mit  Viewtpe: Jyrbol =l
Cell > New View. Die verschiedenen Felder sind  mtfsce name:  [man =]

wie in der nebenstehenden Abbildung auszufiillen.
Die VergroRerung ist gegebenenfalls mit dem = Y&¥name
Mausrad oder mit der Taste - anzupassen. [ Disabls namme validation

I main

® Mit den Tasten + und - kann die Ansicht vergroRert bzw. verkleinert werden (auch mit dem Mausrad méglich). Besonders prak-
tisch ist die Taste Pos 1, da hier die BildgroRe automatisch angepasst wird. Mit den Pfeiltasten ist die Bewegung innerhalb des
Arbeitsbereichs maglich.



2. Zeichnen eines Rechtecks nach Klick auf das Symbol L.

r

3. Erstellen der Ein- und Ausgangsports (,A*, ,B, ,Out®) wie
zuvor beschrieben (Symbole ©/| und D|). Dabei muss be-
achtet werden, dass die gleichen Namen wie im Strom-

laufplan (siehe Schritt 1.4) verwendet werden.

A

4. Nach Auswahl des Symbols v | kdnnen die Beschriftungen B

des Moduls (A, B, Out) hinzugefligt werden.

Ik (O

A
Out > Out

B XOR2

5. Mit dem Pfad-Werkzeug (1) kann das Modul mit den Ports verbunden werden. Die linke
Maustaste beginnt das Zeichnen von Linien, die rechte beendet es.

Schritt 3: Erstellen des Top-Level-Moduls

Das Top-Level-Modul besteht aus:

e Einer Instanz des zuvor erstellten Moduls ,XOR2".

e Zwei Eingangspads mit je einem Eingangsport.

e Einem Ausgangspad und einem Ausgangsport.

e Einem Massepad mit einem bidirektionalen Port.

e Einem Betriebsspannungspad mit einem bidirektionalen Port.

Pad_RZ_Gnd

PadTn

pad L1 A »

Pad L2 B[ >

©

PadIn 1

-

)

Dadend

C

Pad¥dd

PadGnd_1

Padvdd_1

Pad_L3_vdd

FPadTn

©

PadIn 2

.

> o

PadOut
Dadout_1

>Pad_R1_Out

Die Pads sind Anschlussflachen fiir die AuRenanschlisse des Schaltkreises.

Erstellen des Top-Level-Moduls:

1. Generieren eines neuen Top-Level-Moduls:

e Erstellen eines neuen Schematic-Views mit
Cell > New View. Die verschiedenen Felder
sind wie in der nebenstehenden Abbildung
auszufillen.

2. Erzeugen einer Instanz des ,XOR2"“ Moduls:

New view x|
Design: | %oR =l oK |
Cell: | TopLevel j Cancel
Wiew bype: Ischematic ﬂ
Interface name: I main j
View narne: I main
o Disable name validation

e Auswahl der Bibliothek ,XOR" aus der Navigationsleiste ,Libraries. Auswahl der Zelle
,XOR2"“ und klicken auf den Button ,Instance®. Dadurch 6ffnet sich das Dialogfenster

Lnstance Cell".

e Klicken auf die Position auf der Zeichenflache, an der die Gatter erzeugt werden sollen
(gegebenenfalls zoomen). AnschlieBend das Dialogfenster ,Instance Cell* mit ,Done"
schliel3en.



3. Platzieren von zwei Eingangs- und einem Ausgangspad (,PadIn“ bzw. ,PadOut‘) aus der
Bibliothek ,10_Pads"”.

4. Platzieren je einer ,,PadGnd“- und ,,PadVdd“-Instanz. Diese befinden sich ebenfalls in der
Bibliothek ,10_Pads®. Erstellen von zwei Eingangsports, zwei bidirektionalen Ports und des
Ausgangsports wie zuvor beschrieben. Benennung der Eingangsports als ,Pad_L1_A* bzw.
.Pad_L2_B* der bidirektionalen Ports als ,Pad_L3_Vdd* bzw. ,Pad_R2_Gnd“ und des Aus-
gangsports als ,Pad_R1_Out".

Hinweis: Mit der Bezeichnung der Ports Iasst sich die gewlinschte Lage eines Pads in dem
zu erzeugenden Layout angeben. Die Nummerierung erfolgt dabei entgegen dem Uhrzeiger-
sinn, wobei sich Pad_L1_A links oben und Pad_R1_Out rechts unten im Padframe befinden
(siehe auch die Dokumentation der Tanner Tools). Die Pads zur Spannungsversorgung (Vdd,
Gnd) missen immer an gegeniberliegenden Seiten des Schaltkreises angeordnet werden,
damit die Standardzellen von beiden Seiten erreicht werden kénnen.

5. AbschlieRend werden alle Elemente mit dem Verdrahtungs-Werkzeug ( ) verbunden.

pad_RZ_Gnd =) (= Pad_L3_vdd
PadGnd Padvdd
PadIn
PadGnd 1 Padvdd 1
pad_L1 A[ > <
PadIn 1 A
= out D— & >Pad R1 out
Eedin B Padout
HKORZ Padout 1
pPad 12 B[ > £
PadIn 2 —

6. Abspeichern des Designs (File > Save > Save Design XOR).

Hinweis: Durch einen Doppelklick auf ein Symbol, z.B. das des XOR2-Moduls, - _{E} B
wird der zugehorige Stromlaufplan geoffnet. Alternativ kann nach der Auswahl = b
eines Moduls per Klick auf das Symbol & die nachste Hierarchie-Ebene angezeigt

werden. Die nachsthéhere Ebene bis hin zum Toplevel-Modul wird durch Doppel-

klick auf einen leeren Bereich der Zeichenflache erreicht (Alternative: Klicken auf

das Symbol ).

Jetzt kann aus dem Design eine Netzliste erzeugt werden. Diese dient spater als Grundlage fir die
Platzierung und die Verdrahtung in L-Edit. Vorher ist es jedoch sinnvoll, das Design durch Simulation
zu Uberprifen. Mit diesem Schritt befasst sich der nachste Abschnitt.



Il. Simulation mit T-Spice

Durch Logiksimulation kann bereits vor dem Erstellen des Layouts die logische Funktion simuliert und
Uberprift (verifiziert) werden. Dazu kommt das Programm T-Spice zum Einsatz. Die hier behandelte
Beispielschaltung wird durch die Logiktabelle links unten beschrieben.

Zur Verifikation wird fur jeden Eingangszustand ein Testvektor (z. B. |_!) an die Eingange ,,A“ und ,B*
angelegt und gepriift, ob sich der Ausgang ,Out* wie gewiinscht verhélt (im Beispiel ).

Pad RZ Gnd<_>—— a E +——=_>Pad L3 vdd
- PadGnd] Padvdd - -

Print Voltage Padln = Pagena_1 Padvad_1
Pad L1_A[ > © -
Padln_1 e Print Voltage
A | B | Out s
0 0 0 volsagesourcll 1 N
- ot & Pad R1 Out
o 1 5 B ot oman
—— B Padout
1 0 1 - xoR2 Padout_1
1 1 0
Print Voltage Padin la
Pad L2 B[ > O . P
Padln 2 e

¥
veltagesourcll 2 (/| v\m

Zur Simulation werden zusatzliche Elemente im Stromlaufplan bendtigt.

e Alle Signale, die mit einer Instanz des Moduls ,,Print Voltage® verbunden sind, werden spater in
W-Edit angezeigt. In dieser Ubung kommen die Eingangs- und Ausgangssignale ,Pad_L1_A*
.,LPad_L2_B“und ,Pad_R1_Out®in Frage.

e Es werden Spannungsquellen zur Erzeugung der Zustande flur die Testvektoren bendtigt. Daflr
gibt es unterschiedliche Methoden, z. B. die Verwendung von Rechteckquellen mit unterschiedli-
cher Pulsweite und Frequenz. Zu Beginn sind alle Signale logisch 0, so dass an beiden Eingan-
gen eine 0 anliegt. Als nachstes wird die Rechteckquelle mit der kirzesten Periodendauer
(,VoltageSource_1“) logisch 1, so dass der Testvektor 01 anliegt, usw. Eine weitere Mdglichkeit
ist die Benutzung einer bindren Spannungsquelle (Bit) mit passenden Bitmustern.

e Die firr die Simulation notwendige Betriebsspannung wird durch die Spannungsquelle ,Vdd“ be-
reitgestellt.
Schritt 1: Einrichten der Simulation

1. Auswahl der Zelle ,TopLevel“ aus dem Design ,XOR".

=]
2. Kopieren der Zelle ,TopLevel“ mit Cell > Copy Cell. Die o [ - ]
neue Zelle erhalt den Namen ,,TopLevel_Testbench®. O v [

Die bereits erstellte und zur spateren Layoutgenerierung
bendtigte Zelle ,TopLevel” existiert weiterhin.

- Copy ko
Design: #OR, -

Cellname: [ TapLevel_Testbench -

3. Die Zelle ,TopLevel_Testbench“ wird nach dem Kopie-

ren automatisch gedffnet. [
" Needed gnly
4. Auswahl und Platzieren der zwei Rechteckquellen ca
.VoltageSource_1“ und ,VoltageSource_2“ aus der Bib- ¥ Gverwrke sxisting col _
liothek ,SPICE_Elements“. Dazu soll im Feld ,Interface” I Diatlenae vaidatien =T

die Option ,Pulse” ausgewahlt werden. Die ,Properties®
sind wie auf der nachsten Seite beschrieben auszufillen.



Instance Cell Instance Cell

Instance name; | VoktageSource 1 Instance game; | VolkageSource_2

[~ Disable name validation [~ Disable name validation

r—Instance of rInstance of
Design: ISPICE_EIements j Design: ISPICE_EIements ﬂ
Cell name: Ivoltagesource j Cell narne: I\-'oltageSource j
Interface: Pulse - Interface: IPuIse j
Syrbol wigw: IPuIse j Symbol view: IPuIse j

Properties: Properties:
MName | Walue Marme | Yalue
Delay 100ns Delay 150ns
FallTime 5ns FallTime Sns
Period 200ns Period 400ns
Pulsetidth 95ns Pulsewidth 195ns
RiseTirne Sns RiseTirme Sns
ROUMND 1] ROUMD a
WHigh S YHigh S
Yiow 0 Ylow e

Cuore: | Done |
4 &
. « .
Auswahl und Platzieren der Quelle ,Vdd*. Dazu wird [EEEE

.SPICE_Elements“ > ,Voltage Source” gewahlt. Im Feld

.Interface” soll die Option ,DC*“ ausgewahlt werden.

Auswahl des Massesymbols ,,Gnd“ und des Betriebsspan-
nungssymbols ,Vdd* aus der Bibliothek ,Misc* und platzie-

ren gemalf der Abbildung oben.

Auswahl und Platzieren der drei ,Print Voltage“-Instanzen
aus der Bibliothek ,SPICE_Commands®. Verbinden der

Symbole mit den Eingangs- und Ausgangssignalen.

Auswahl des Symbols B und Verbinden aller Symbole

geman der Abbildung oben.

Instance narme: widd
" Disable name validation

—Instance of

Design: ISPICE_EIements j

Cell name: I\u'oltageSource j

Interface: Dz =

Symbol view: IDC j
Propetties:

Mame | Walue

W 5.0

Die Festlegung der Simulationsparameter erfolgt mit ,Setup = SPICE Simulation®. Es 6ffnet

sich ein Dialogfenster.

e Option ,General“ auswahlen und die verschiedenen Felder wie in der folgenden Abbildung

gezeigt ausfillen.

[N Setup SPICE Simulation of cell "TopLevel_Testbench®

I g Cptions
Hierarchy Priority
Additional SPICE Commands
Parameters
PICE Cptions
0 Operating Point Analysis
ransient/Fourier Analysis
| DC Sweep Analysis
[ 1 AC Analysis
] Moise Analysis
(] Transfer Function Analysis
[ ] Termperature Sweep
[ Parameter Sweep
] Corner Simulations

X

B General
Reference Temperature {deg, C)
Accuracy and Performance
B Simulation Dutputs
Show Waveforms
Enable Waveform Yolkage Probing
Enable Waveform Current Probing
Enable Waveform Charge Probing
(= File and Directory Names
SPICE File Mame
File Search Path
Include Files
Library Files
‘erilog-A Search Path

Default

During
False
False

. JLibrariesMadels

“eneric_025.5b" TT <:

Genau so Ubernehmen!
Mit Anfiihrungszeichen
und Leerzeichen vor ,TT*.




10. Abspeichern des Designs (,Save Design XOR").

Option , Transient/Fourier Analysis® auswahlen und die verschiedenen Felder wie in der fol-

genden Abbildung ausfiillen.

[N setup SPICE Simulation of cell ‘TopLevel_Testbench®

x|

General
Metlisting Options
Hierarchy Priority

Stop Time
Mazximum Time Step

100ps

Additional SPICE Commands
Parameters

SPICE Options

DC Operating Point Analysis
[ DC Sweep Analysis

Print Time Step
Use Initial Conditions
Startup Mode

[= Fourier Analysis

ransient/Fourier Analysis

Schritt 2: Durchfiihrung der Simulation

1.

Enable Fourier Analwvsiz

Falze

Starten des Simulators T-Spice durch Klick auf das Symbol ¥ in S-Edit.

2. Gegebenfalls die ausgegebenen Meldungen mit ,Ja“ bzw. mit ,OK* bestatigen.

% windows-Sicherheitswarnung

\l’)

‘ou are abouk ko run a sirmulation job with T-Spice,
Communication with T-Spice uses TCF port 5885,

If ywou have a Firewall active this communication could

be mot allowed by defaulk, In case if you experience problems,
please configure wour firewall to allow this connection.

Mote that all data will be transmitted inside vour computer
and no data will be transmitted or received From elsswhers,

‘Would vou like to proceed with starting T-Spice and sending simulation data?

—

Mein

Der Windows-Firewall hat aus Sicherheitzgriinden einige
Funktionen diezes Programms geblockt.

des C kann das Blocken diezes Programms

Mame: Tanner W-Edit Waveform Viewer

Herauzgeber:  Tanner EDA, a division of Tanner Research Inc.

@eldung fiir dieses Pragramm nicht mehr anzeigen
0K |

DerWwWindows-Firewall hat die Annahme von Yerbindungen aus dem Internet oder
einem anderen Metzwerk fur dieses Pragramm geblockt. Sie konnen die Sperung
aufheben, wenn Sie das Programm kennen oder dem Herausgeber trauen. Wann

zollte die Spermung eines Programms autgehoben werden?

3. Es offnet sich W-Edit zur Darstellung der Eingangs- und Ausgangswellenformen. Der Menu-
punkt Chart > Expand Traces weist jedem Signal ein eigenes Diagramm zu. Nun kann das
Ausgangssignal Uberprift und mit dem gewlnschten Resultat verglichen werden.

BB o o -
52 e m By

1 x DKDRZ:schemal
T —

o]
File Edit View Draw Chart Setup Window Help -8 X
D@B"ﬁ\x.}éé\ﬂﬁ\é‘?g\o_‘ |["select [ movE [ seLEcT
Rl pdszmte| AN A S 2@+ - @RS 8]lm= =815 [ L00su:145

4%

[) Chart1 (Transient) |
Tanner T-Spice 15.16

40000

|selection: <none>  [seec | [ [p[wum[or 4

10:24:01 02/28/12f

Hinweis: Durch Auswahl des ,Probe-Voltage“-Symbols (%) in S-Edit kann jedes Signal durch Klick
auf das zugehdrige Netz angezeigt werden, z. B. zur Fehlersuche.

4. Schlieen von W-Edit und T-Spice.

5. Abspeichern des Designs (,Save Design XOR").
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lll. Exportieren der Netzlisten

Aus dem simulierten Stromlaufplan wird eine Netzliste im TPR-Format (Tanner Place and Route) er-
zeugt. Diese wird vom Layoutwerkzeug L-Edit/SPR (Standard Cell Place and Route) verwendet, um
das Layout zu erzeugen.

Aus dem Stromlaufplan wird weiterhin eine Netzliste im SPICE-Format erstellt, die flir den nachfol-
genden Verifikationsschritt (LVS) bendtigt wird.

Vorgehensweise:
1. Auswahl des Designs ,XOR" aus der Navigationsleiste ,Libraries".
2. Offnen der Zelle ,TopLevel“ (nicht der Testbench) durch Doppelklick.
3. Exportieren der TPR-Netzliste mit File > Export > Export TPR

4. In dem neuen Dialog wird als Dateiname ,TopLevel.tpr eingetragen. Ein Klick auf ,Export*
schlielt das Fenster.

Export TPR x|
e | =
E '\ Tanner' X OR\TopLevel fpr - oco
Cancel |

—Expart saurce

Design: I HOR LI

cell: I TopLevel =]

Wigw I schematic LI
—Export contral property

Property name: I TFR LI
—Options

[ Export toplevel ports as pads

5. Die SPICE-Netzliste wird Uber File = Export = Export SPICE erzeugt. Eine eventuell vor-
handene alte Datei kann Uberschrieben werden.

Export SPICE x|

General |Hierarchy PriDrityl

—Tofile
IiE:\Tanner’\XOR‘\TopLevel.spci ﬂ |

[~ Caonfirm aovenwrite

—Exporn source

Design: IXOR LI
cell: |TDpLeveI LI
Wi |schematic Ll

6. Schliel3en von S-Edit.
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IV. Layoutentwurf

Nun wird L-Edit/SPR (Standard Cell Place and Route) verwendet, um das Layout des Designs zu
generieren. Die Layouterstellung beinhaltet das Platzieren (Placement) und Verdrahten (Routing) der
Standardzellen und AuRenanschlisse (Pads).

1. Kopieren aller Bibliotheksdateien aus dem Verzeichnis ,E:\Tanner\Libraries\Tech Files\“ in
das aktuelle Design-Verzeichnis (z. B. ,E:\Tanner\XOR\%).

2. Start des Programms L-Edit.

3. Auswahl der Technologiedatei, der Netzliste und der Standardzellenbibliothek:

Zuerst werden die Technologie-

Informationen durch Auswahl von

x|
Frarm file:
File > Replace Setup importiert. ﬁﬁi |
ATannety=<OR\Tech_Infotdb Browse...
Im Dialogfenster wird nach Klick auf ﬂl
,Browse“ die Datei ,Tech_Info.tdb" L et | Uncheck Al |
im aktuellen Verzeichnis lokalisiert. rp ——

Verlassen des Fensters mit ,OK". Die ausgegebene Meldung nochmals mit ,OK* bestatigen.

Durch Auswahl von Tools = SPR = Setup wird das Dialogfenster ,SPR Setup® geoffnet.
Hier wird als Standardzellenbibliothek ,morbn20d.tdb“ und als Netzliste ,TopLevel.tpr ein-

getragen.
Mit ,Initialize Setup“ werden jetzt die Standardzellenbibliothek und die Netzliste geladen.
x|
etu_p Tools Window Help
= Generate Layers. ., e mE = I 3 -~ Standard cell library fi
o Clear Generated Layers.. L= o m 55 @ T Er— \LI
| e FETeava| ) S
B DRCEox [ amigwn - Nelst i
E?;:dfzu:;r;en'y Flags... L e W Em&l
Clear Error Laver... L e e e =
Eiead neflist show mapping table: Iapping Takle...
Enable Interactive DRC Alt+D P
Werffication Error Mavigator L4 SR Read netlist, initialize setup dialogs:
SOL Mavigator L
. r Remowve power and ground nete from the netlist and
) Flace and Route... power and graund pins from the gates during reading
Eriiach SDF Driver Pronertes b
i~ PowerfGround node and portnames
Puower signal: IVdd Core Setup.
Ground signal |Gnd
Pad Route Setup
4. Bestimmung der Eigenschaften des Padframes®. x|
Auswahl von ,Padframe Setup“, um den Dialog | Peamedmensicns iLombde) Reset |
,SPR Padframe Setup* zu 6ffnen. o Dm il N
nter jor automatic ad|justrmen
In der Registerkarte ,Layout® kdnnen die Ab- P | : : |
. . # Instance name Side Mirrar Power/Ground
messungen des Padframes bestimmt und die Fadin Tet Mo .
Lage der Pads gepriift werden. R v
4 PadOut_1 Right Mo
. . « . . 5 PadGnd_1 Right Mo Gnd
Unter ,Padframe dimensions“ wird die ge- :
winschte Breite (,Width“) und die HOohe
(,Height*) des Padframes eingegeben. Wird hier
jeweils 0 angegeben, werden Breite und Héhe Orcter poct countsrclackowise, uppet &f - botom - ight-top.
automatisch festgelegt. b Delet>_|
Abbrechen

* Der Padframe ist der auere Rahmen, auf dem sich alle AuRenanschliisse (Pads) befinden. Er stellt die Verbindung zur ,4u-
Beren Welt“ dar — z. B. zur Leiterplatte (bei Nacktchip-Verarbeitung) oder zu den Schaltkreis-Anschlussbeinen (bei gehdustem
Chip).
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Die ,Padlist” gibt die Lage der Pads an. Die Nummerierung (Spalte ,#*) erfolgt dabei gegen
den Uhrzeigersinn, wobei sich Pad 1 links oben im Padframe befindet.

Durch zweimaliges Klicken auf ,OK* werden eventuelle Anderungen Gbernommen.

5. Automatischer Layoutentwurf in L-Edit/SPR:

Nach Auswahl von Tools = SPR = Place and Route 6ffnet sich der Dialog ,Standard Cell
Place and Route“. Um das komplette Layout zu generieren, werden alle drei Module (,Core
place and route®, ,Padframe generation“ und ,Pad route“) ausgewahlt (siehe Abbildung).
Eine geeignete Optimierung (,Placement‘ und ,Routing®) ist auszuwahlen. Das Layout wird
nach Klick auf ,Run® automatisch erstellt.

Standard Cell Place and Route 1]
l [v Core place and route l
Run

[ Globalinput signal routing
Core configuration Accept |
Constraint ISquare LI
B length (Lambds) 0.000 Cancel |
Iurmker of rows 0
[ Indent micdle rows iddle/tapratio 1.0 Sstup |
Flacement

’7|_ Optimization Optimization factar; 0.0 ‘
Routing
[v Optimization Netlength and 'ia Feduction LI ‘

Output ogtions
[ Label nodes with ports

I_erteCAPﬁle IC\Arbelf\REE\ZmZ\Tanner‘\XOR\Top Browse... |
[ Wite SDFfile IC\Arbeif\REE\EU]2\Tanner‘\><OR\Top Browse... |

[¥ Paclframe generation

[+ Pad route

Der Abschluss von Platzierung und Verdrahtung wird mit einer Meldung quittiert. Nach der
Bestatigung durch ,OK* wird das generierte Layout dargestellt5:

Vdd-Anschluss der
Standardzellen

Pad 1 (A)

Signalverdrahtung
(Kanalverdrahtung)

Pad 3 (Vdd)

Gnd-Anschluss der
Standardzellen

Kern (Core), be-
stehend aus funf
Standardzellen

® Mit den Tasten + und - kann die Ansicht vergrofRert bzw. verkleinert werden (auch mit dem Mausrad méglich). Am praktischsten ist
die Taste Pos 1, da hier die BildgroRe automatisch angepasst wird. Mit den Pfeiltasten ist die Bewegung innerhalb des Arbeitsbe-
reichs moglich.
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V. Verifikation des Layouts

Die Layoutprifung (Verifikation) beinhaltet zwei Schritte:

e Prifung auf Einhaltung der Technologieregeln: DRC (Design Rule Check)

e  Prifung auf Ubereinstimmung mit dem Stromlaufplan durch Netzlistenvergleich: LVS (Layout ver-
sus Schematic).

Wahrend der DRC direkt im Layout durchgefuhrt wird, erfordert der LVS aus dem Stromlaufplan
(S-Edit) und dem Layout (L-Edit) erzeugte SPICE-Netzlisten. Zur Netzlisten-Erzeugung aus dem Lay-
out dient die Extraktion mit L-Edit/Extract. Die dabei zu erkennenden Schaltungselemente sind in ihrer
Beschreibung (z. B. als konkrete Ebeneniberlappungen) in einer Extraktionsdatei (extract definition
file) festgelegt.

Schritt 1: Prifung auf Einhaltung der technologischen Regeln (DRC)

L-Edit/DRC ist ein Werkzeug, das ein Design auf das Einhalten von Entwurfsregeln (z.B.
Uberlappungen, minimale Breite und minimaler Abstand) hin Gberpriift. Durch Auswahl von
Tools > DRC wird die Verifikation gestartet. Nach Abschluss der Verifikation zeigt ein Dialog-
fenster, ob das Layout die Regeln einhalt.

x|
gy s 2 |&lE4E] v [X
[erars [ chip Fll =

Ma errars to display.
Fun DRC or Extractto find rule violations and display them here.

sefup | Tools Window  Help

fd [p  Generate Layers..
Clear Generated Lavyers...

| T

Srom DEC

etault

%

o 1

L]

Schritt 2: Netzlistenvergleich (LVS)
1. Generierung einer SPICE-Netzliste aus dem Layout mittels L-Edit/Extract:

e Zur Konfiguration der Layout-Extraktion, wird Tools - Extract Setup ausgewahlt. Es
Offnet sich das Dialogfenster ,Setup Extract®.

Setup Extract il Setup Extract i‘
Genrl | opons| e
Extract Rule Sets to mn — Statements to include before nedl
VA O A 2 =
[ |
~Output optio

[ irite empty subcircuit definitions
[v rite .madel statements

Calibra dafines: |
[ Save node-highlighting data: To folder

SPICE extract output il

ﬂ%— - Davice label
E {Tanner<OR\T opLevel_Layoul spc
a vousp [~ Place ports as device labals
Browse. Edit
4 —I Tolayer | |
[~ Overwrite existing output file
[~ Open SPICE outputfile after extracting  *Hier Yerity" optia
~When extract campli [ Wit hisrarchical netlist [~ ‘Write node name aliases
[~ Send email to Configurs. .. [~ Pun in background
Lock participating cells while extract runs
[~ Play sound: Configure... r i A
[~ Pop up message hox [ Onlyforwarmings Exiractas.
’76 Toplevel cell " Subcircuit ‘
K] Abbrechen Abbrachen
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e Im Feld ,Extract Rule Sets to run“ (Liste der Extraktionsdateien) wird die Datei
~,morbn20.ext im aktuellen Design-Verzeichnis angegeben.

e Im Feld ,SPICE extract output file® (zu erzeugende SPICE-Netzliste) wird
~TopLevel_Layout.spc” eingetragen.

e Auf dem zweiten Reiter ,Options” diirfen in der Gruppe ,HiPer Verify options* keine
Felder ausgewahlt werden.

Die Auswahl von Tools = Extract startet die Extraktion. Dabei auftretende Warnungen utber
unattached ports und short circuits kénnen ignoriert werden. Im Ergebnis liegt eine Netzliste
im SPICE-Format vor, welche das Layout in Form von Bauelementen und Verbindungen be-
schreibt.

Abspeichern des Layouts als ,XOR_Layout.tdb“ und SchlieRen von L-Edit.
Start des Programms LVS.

Nach Auswahl des Symbols & bzw. File & New o&ffnet sich der Dialog ,New File“. Dort wird
,LVS Setup“ ausgewahlt und durch ,,OK* bestatigt.

Es folgt die Definition der zu vergleichenden Netzlisten. Uber ,Browse“ werden die aus dem
Layout extrahierte Netzliste ,TopLevel_Layout.spc“ und die Netzliste des Stromlaufplans
~TopLevel.spc* ausgewahlt.

LV Layout Versus Schemal _ ol x| B setup1 =[O
Fle  View Setup erficaton Window Help Input | Output | Device Perameters | Merge Devices | Porasitics | Options | Performance |
Netlist
Leyeutratist  [repics  SIffE ememorloptove tevomspe | Bowse. | e
File type:
Schematicneflist [T-Spice v IE\TEnnEr’\XOR\TDpLEvE\SpE I Browse.. | Edit
Cancel
- Optional input fil
[ Premach file [ Browse. | | Edit
Ready Lne 107 P [~ Element description file: | Brawse. Edjt

Auf dem Reiter ,Merge Devices" muss der Eintrag in der Zeile ,Mp* auf ,All* gesetzt werden.
Das bewirkt eine automatische Zusammenfassung paralleler Transistoren, so dass diese zu
keiner Meldung Uber Unterschiede zwischen den Netzlisten fihren. Weiterhin muss der Punkt
.Remove shorted devices“ ausgewahlt werden.

=lEiE=
arasi(icsl Opticns |Per¢orman:e|

parallel M. and stacked M which share gates

Input | Output |DevwcaParame(er

~Merge series and parallel R, L G parallel B. D, J. Q.

SetAll |

SetMone

R Nane

None

Nane

None

Nane

None

[ | I | | K

o - oo o r

Nane

MNone

4

4

Mp: |Al
Ms I\Eua 1= | |

— Series MOSFET optimization (rest series MOSFETS as lngically
Series MOSFET:  |Mane =1
™| Find series WMOSFETs that differ in order or parametervalies

Remove device:

’7 IF« Remave shorted davicas I [~ Remove disconnectsd devices
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7. Nun kann der Netzlistenvergleich _lol x|
durch Klick auf das Symbol B

Layout netlist E\TannefxOR TopLevel_Layout spe Parsed and Flatiened
bzw. Auswahl von Verification > Schematic netlist E{\Tanner<OR\TopLevel spe Parsed and Flatiened
Frematch file: -

Run gestartet werden.

Element description file
Outputfile
Node and element list:

8. Als Ergebnis wird angezeigt, ob
die beiden Netzlisten dieselbe | sumEEEEEEEEEEEEEEEEERENEERENEERENNRERRNNERNNNNRNNNNNRNNNNNNNNNNRRNNN]
Schaltung beschreiben oder ob sie
Unterschiede aufweisen.

Current process

‘ Result  Gireuits are equal Note: Devices have been merged.

Overall pracess

9. SchlieRen von LVS. 304 dome. -
95% done.
100% done.

FINAL RESULT

Mote: Devices have been merged.
Circuits are equal.
Run time: 0:01 (min:sec)

VI. Export der GDS lI-Daten aus L-Edit

Abschlieend kénnen die GDS Il-Daten aus L-Edit fir die IC-Herstellung exportiert werden. Folgende
Schritte sind dazu notwendig.

1.  Start des Programms L-Edit und Offnen des Designs ,XOR_Layout.tdb".
2. Nach Auswahl von File = Export Mask Data = GDSII 6ffnet sich ein Dialogfenster. Dort wird

im Feld ,To file“ der Dateiname ,XOR_Layout.gds" eingetragen. Ein Klick auf ,Export® er-
zeugt die GDS II-Datei.

Export GDSII x|
~Tofila GDSIl units:

||><OR7LayUul.gd5 l Browse | (" GDSIl default {1 database unit= 0.001 microns)
W i ® Custom: 1 datebaseunit= |0.007 micrans

1 database unit= [0.001 user units
—Logfile:

[ Save logfile to:

~Cellnarmes

I Browss.. | @ Presene case ¢ Uppercase " Lowercase
[+ Open log inwindow Restrict cell names to 32 (Standard) | characters
[ Do not export hidden objects and layers ~Expart call
[+ Owerwrite object data type with layer data type @ Allcells
[ Caleulate MOBIS checksum (" Selected cell and its hierarchy
[~ Check for self-intersecting polygons and wires
Cell: [Chip
[ Write MrefCells as links
Fracture:

[~ Fracture polygans with more than

144 verices

| Expoart II Cancel

3. Schliefen von L-Edit

Literatur

Onlinedokumentation der Tanner Tools
(unter Start > Programme - Tanner EDA - ... 2 Documentation verfligbar)
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Glossar

ASIC

Contact

Core

Gate / Gatter
GDS 1l

Gnd / GND

Instance / Instanz

Layer
Layout

LVS

Mixed-signal (circuits)

Modul

NAND-Gatter
Netzliste
NOR-Gatter

Pad
Padframe
Pad routing
Port

Power rail
SPICE
Standardzellen

Top-Level(-Modul)
TPR (Format)

Via
Vdd / VDD
XOR-Gatter

Application-Specific Integrated Circuit — anwendungs-
spezifischer integrierter Schaltkreis — fiir eine spezielle
Anwendung entworfener Schaltkreis

Durchkontaktierung zum Verdrahtungsanschluss einer Zelle

Bereich einer Schaltung, in dem (Standard-)Zellen und ihre
Verdrahtung angeordnet sind (ohne Pads / Padanschllsse)

Zelle zur Realisierung einer logischen Funktion (z. B. NAND)

Binares Dateiformat fir Layout-Informationen — wird an den
Schaltkreishersteller Gibergeben

Ground, Masseanschluss

Virtuelle Modulkopie durch Referenz auf ein Originalmodul
(Ableitung eines Bibliotheksmoduls zur Nutzung in Schaltung)

Darstellungsebene

Topologische Darstellung der einzelnen Materialebenen eines
Halbleiterchips

Layout Versus Schematic, Vergleich der Netzlisten von
Layout und Stromlaufplan

Integrierte Schaltkreise, die sowohl digitale als auch analoge
Funktionalitat beinhalten

Funktionelle Schaltungseinheit, wie z. B. ein Gatter, ein
Verstarker oder auch das komplette Design (Top-Level-
Modul)

Gatter, das Eingangssignale mit einem logischen UND
verknUpft und dann negiert

Textuelle Beschreibung der Verkniipfung von Bauelementen
bzw. Gattern mittels Netzen

Gatter, das Eingangssignale mit einem logischen ODER
verknUpft und dann negiert

Auflenanschluss des Schaltkreises
AuRerer Ring, auf dem Pads angeordnet werden
Verbindung der AuRenanschlisse mit dem Kern (Core)

Symbol fir Signalein- und -ausgange eines Moduls im
Stromlaufplan

Stromversorgungs-/ Masseflachen links und rechts vom Kern
Simulation Program with IC Emphasis, Simulationswerkzeug

Gatter, die zur besseren Reihenanordnung alle dieselbe
Hoéhe besitzen

Oberstes Modul in einer Design-Hierarchie

Tanner Place and Route Netzlistenformat — enthalt die
Beschreibung eines Designs in Textform und die
Verknupfungen mit den verwendeten Standardzellen

Durchkontaktierung zwischen Metallebenen
Stromversorgung der Standardzellen

Gatter, eXclusive OR, exklusives Oder — Ausgang ist genau
dann logisch ,1“ ist, wenn an einer ungeraden Anzahl von
Eingangen ,1“ anliegt und an den restlichen ,,0*
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